User’s Manual

ULTRA CCTV
TIGON 1648
Digital Video Recorder

Open the CD DISC for

1. Complete user and installation manual.

2. Central Management Software.
3. Remote Viewing AP Software.

CEFC



Power: Power On / Off switch
REC: Recording

PLAY: Playback

SEQ.: Channel sequence

HEEEH Split screen selection

0~9: Channel select

Zoom: Live zoom (2x)

FREEZE: Freezing live image

MENU: Shortcut of frequently use functions

Setup: Enter setup OSD menu

Spot: Activate Call monitor. Quick Setup (Sequence ON/OFF, Fixed camera)

Frame by frame Frame by frame
<] | reverse | [> forward <I<] Fast reverse [>|> Fast forward

[] Stop playback

)

o

é 8 é Direction button up/down/left/right
v Enter button
(-

PTZ: Enterto PTZ control mode
ESC: Exit menu

Alarm : Alarm output force control
Backup: Enter to backup mode



System rear connection detail

1) Video Source Connection

It connects video sources (camera image) to BNC connector via cable.

2) LOOP OUT Connection

BNC connector of LOOP OUT can be used as output to other device’s input.

Caution : It may cause low quality of picture when connecting disconnected cable from any device
to LOOP OUT BNC.

3) Monitor Connection

CVBS OUT/SPOT : It connects normal CCTV CRT monitor.
S-VHS : It connects monitor that supports S-VHS(S-VIDEO)
VGA : It connects PC monitor or LCD monitor (not supporting DVI)

4) Audio Connection 5) Network Connection
—— AUDIO IN——  AUOIO

66600 x

LAN

It connects audio source (mic) to audio

. It supports 10/100 BaseT, connects
|npu_t of RCA and connects speaker to Cat5 cable with RJ-45
audio output.



6) RS232 port Connection.

RC-232C

Reserve for technical support

7) USB port Connection
% usB
front rear

Both USB port support USB devices such as USB mouse, USB external HDD and USB thumb
drive

8) ALARM IN (SENSOR) Connection

ALARM IN
l1 234G6586780G 91011126 1314 1516 Gl

HEEENEREREREREREEN

[ [ [ [ [ [ [ [ [ [ [ [ [ [ [ [ [ [ [ |

Remark : Max 6V/50mA

9) ALARM OUT Connection

Gcidzesc
| ] l |
- OIOIOIONOIO

* Alarm output 1~4CH
Support either NC or NO
Remark: Max24V/2A



10) Factory Reset Switch and NTSC/PAL system Switch

O [O1 <« NTSC/PAL Shift Switch

T NT  PAL

Factory Reset Switch

Press the factory reset switch located at the left side of NTSC/PAL switch to return to factory
default setup values.

This reset switch should be pressed during power on. After OSD prompts "Factory reset
detected" message, then you can release the switch. The booting procedure would go on under
resetting setup values

Turn off the DVR before you do the NTSC/PAL system change.
Restart the DVR again after the system mode changed is done.

North America: NTSC
Europe: PAL

11) Power Connection and power switcher

ON

L = =




Installation Guide for HDD & CD-RW/DVR-RW devices

You must set the hard drive Master and Slave jumper properly according to Hard drive
manufacturer's instructions to prevent system error and data loss.

Description

1. CD-RW/DVD-RW devices should be installed as “Primary Slave”.
2. First HDD for system needs to be installed as “Primary Master”.

FLELE

L.

SMPS

MAIN
BOARD

Guide Chart for installing several HDDs

MASTER : HDD#1
~

JR 1: PRIMARY

S sLAVE :cD/DVD

MASTER : HDD#2
\JR 2 SECONDARYZ

S SlAVE :HDD#3

CD-RW/ DVD-RW
HDD i
Devices
Installed HDD System
IDE Connector IDE Connector
PRIMARY
HDD x 1 HDD#1 JR1 SYSTEM
MASTER
PRIMARY
HDD#1 JR1 SYSTEM
MASTER
HDD x 2
HDD#2 SECONDARY JR2
MASTER PRIMARY JR1
PRIMARY SLAVE
HDD#1 JR1 SYSTEM
MASTER
SECONDARY
HDD x 3 HDD#2 MASTER JR2
SECONDARY
HDD#3 JR2
SLAVE




System On
« Put the power to the DVR.
« Turn on the power switch at the rear and press power button in front.

« It takes about 100 seconds to boot (It may take more when network cable isn’'t connected)

System Shutdown
« Press Power button, then shutdown menu appears. Enter power button to shutdown system.
* Or select [SETUP > SYSTEM > SYSTEM SHUTDOWN] to shutdown system.

«|t takes 30 seconds to shutdown.




on Screen

2.CAMR2
i

K N
9. cAM N |
.|

i

13.cmmf3‘
Ld 4

<Screen Indication>

Top-Left

Top-Right

Central

@ Status Bar

: Camera title

P — Pan/tilt (PTZ control)
A — Audio

: Record mode (Blue-Normal, Red-Event)

Motion status

: Video Loss, Hidden Camera

: DVR status Indication

(Backup, HDD usage, Current Time, SEQUENCE, FREEZE, Login info. etc)



Screen Split

Press DISPLAY button or mouse menu: changed on 1 ->4 ->9 -> 16 by turn

Direct Channel
1) Press channel No. on the remote control or front panel.
2) Click the screen to watch specific channel using mouse.

** Pressing No.1 button responds a bit delayed to wait a possible signal input of

No0.10~16 (approx 2.5 seconds)

LOG IN —
Login to menu for setup | USER NAME | admin n
Default: ID —admin 1 PASSWORD | * =D
PASSWORD - 1 L=
o) (canes)
ACAUTION

Itis recommended to change ID and PW for your safety.

CAMERA ALLOCATION function (changing camera display position)

1) Press Enter in the monitoring screen, then
box is selected at No.1 camera.

2) Locate the box to the camera No. you want to
move using direction buttons.

3) Enter the camera number to switch

4) Then, selected camera is switched with the
Camera number you pressed.

5) To exit, press ESC

Ex) Switching camera No 4 and 12.
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|

Menu Bar * Click MENU button or right button of mouse

HIDDEN

[ e
: .M DISPLAY
_J L | 1,4,9, 16
; : Split screen change (the same as DISPLAY button)

FaMIC RFCORD

ik AIN | e RS
SEAmCH - Sl T
(& I_"I

macKur

MISCELLANUEOUS  » .}
“LH1S sy

Also can split 4 division window for display
chl ~ch4, ch5~ch8, ch9~chl2, chl3 ~ chl6

+) d
16.CH18

VIDED LOSS

16 16:30:43 -

MISCELLANUEOUS

SEQUENCE
Sequence camera group regularly

FREEZE
Pause the screen

ZOOM

1 Full Live screen available only.

Select Zoom : Press zoom button and locate the box to magnify using direction keys
Move Zoom : It can be moved using direction key after press Enter.

<ZOOM selected screen> <ZOOM screen>

Zoom screen may provide low quality or be shaken as formatted digitally.




SPOT

2 spot monitors are supported and sequence / fix mode can be selected.
Select the Spot monitor in SETUP>DEVICE>SPOT MONITOR.

SPOT MONITOR

SPOT NUMBER

L =

| ENABLE SEQUENCE ®O

| FIXED CAMERA a

1

o) (e

No OSD indication of camera number for SPOT output.

PTZ

Pan Tilt/Zoom/Focus/Iris Preset setting and moving functions are supported.
Each function can be different from each PTZ protocol.

CEEELL
@800

ALARM
Control Alarm output function.

ALARM NUMBER

I ENFORCED CONTROL

| ALARM CONTROL n
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STATUS

RECORD
Displays current recording status

EVENT

Displays current event information (motion/alarm).

DISK
Displays current Disk information

NETWORK
Displays current network information.

Also displays current connected client information.

|

— ~ (mecoso | (ETIIR YT (RIS

r

CAMERA  RESOLUTION S QUALITY AUDIO

1 IRon240 30 FPS G

2 I60x240 J0res HIGH .

3 3802240 Jores HIGH =

4 I60n240 J0FPS NORMAL

s 1605240 10 FPS HIGH

[ 60140 10 FPS MORMAL

- 1605240 30 FPS HIGH

" M0n240 50 FPS oM

112 B

& 7T 89 1ngu 13 14 15 18 |
& 7 R 9% 10 11 12 13 14 1S 18
.7

B 5 10 11 13 13 14 15 18

CAPACITY SPACE TEMPERATURE SMART

| 1 SENVEN INFORMATION

SAMSUNG SP1  114G8 1138 a2c Goon

TESTearpcD-B

MAC ADDRESS DO:13:40:00:08:02
[ 192 168.0.1
METHMASK 255.255.0.0
GATEWAY 192.188.0.1
ONs 180.138.83.1
DoNS

¥ CLIEMT INFORMATION

]
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PANIC RECORD
Set recording mode in an emergency situation.
Press SETUP>RECORD> EVENT RECORD>FPS/QUALITY

SETUP
Select to enter into SETUP menu

CAMERA COLOR
CAMERA COLOR Qpcamea (1[5

Changes camera screen color t BRIGHTHESS | 128 B

I HUE 128 B

| CONTRAST 128 B

I SATURATION 128 B

(o] (cance]

OosD
Changes OSD (On Screen Display's position.

| HORIZONTAL 25 i
| VERTICAL 5 B

SEARCH
Select to enter into SEARCH menu
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BACKUP
Select to backup recorded data.

1) Backup Device Search

. BACKUP

SEARCHING BACKUP DEVICE, PLEASE WAIT

2) Select data to backup

' sTARY a7 00/18 m:az:m )
1 END w007 jom 14 w2:oa:se )
¥ BACKUP CAMERA ALL =3
| BACKUR DEVICE TESTearpCD-WEW SH-RE3IC n
§PILE TYPE HATIVE u
MELUBING

< aumio < Evewt = A ipwes

3) Calculate data size

BACKUF DATA SIZE - Y15MB

4) Warning when data size is over

L CAUTION

o BACKUP DATA SIZE IS BHOGER THAM
ITS FREE SPACE, TONTINUET

(o) (e

5) Make Image after pressing OK.

BACKUP 2/3

mnms ] &%

(o) Gy

6) Burning to CD

{ BACKUP 3/3

It would block remote search during local backup procedure.
If users use defective media to backup, it might cause system reset
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BACKUP
Use USB device to backup .

1) Backup Device Search 4) Warning when data size is over

BACKUP

BACKUP DATA SIZE IS BSGGER THAN
ITS FREE SPACE, CONTINUE?

SEARCHING BACKUP DEVICE, PLEASE WAIT

5) Copy data to USB driver

2) Select USB device to backup

R R ¢

[+ _200a 03708 wo:es:e [
(| tem 2008 /03708 w0:53:34 [
s - (o)
| BACKUP DEVICE (userocardmesderzoo
| FLETYFE '-.mn n
‘ [ ¥ [avosa | ¥ e (3 T v J f =y
¥ 4 BACEUIP M FROGCESS, PFLEASE WAIT
L 50 (o) | e
——
[ o

3) Calculate data size 6) Backup to USB completed

BACKUP 1,2 | CAUTION

BACEUF DATA SIZE : 24MB o EBACKUP COMPLETED

[cancer) fmimzg
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Note : After Backup to USB device , use windows Media Player to play the AVI file , if
your Media Player can’t shows any video , it should be the codec problem , you have
to visit the Xvix web site , http://www.xvid.org to download the Xvid codec and install

to your computer .

1) Media Player can’t shows any video 2) Visit the Xvid web site to download Xvid codec
http://www.xvid.org

)] |@ hittpeffweasae veid orgl

> xvid

b Choose Your Destination:

Looking for

MUTE
Sound off

LOGOUT
Press SETUP>SYSTEM>USER

@ DO YOU WANT TO LOGOUT?

o) [coveet)
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SETUP SCREEN

SYSTEM
RECORD EVENT INFORMATION NETWORK DEVICE
DATE/TIME
DISK
USER
LOG
LoGouT
SYSTEM SHUTDOWN

99".- 2007708/16)

SYSTEM SETUP

INFORMATION: To show DVR information
DATE/TIME : Setup date and time

DISK . Show the HDD status and format HDD
USER . User login ID and password setup
LOG : System operation information
LOGOUT . Logout system

SYSTEM SHUTDOWN: To shut down DVR

Remark: It takes more than 10 seconds to initialize (delete) the LOG information
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INFORMATION

INFORMATION
DEVICE NAME: User can change the DVR

BEVICE MAME ovn

name on his own. Lancusce tnein [+]
arae [rcasor

=

=

LANGUAGE : Select language. B | | coaumanon swast _
VERSION : Shows S/W version info. i

(With UPGRADE button, you can upgrade

the newest S/W version) I i & - : Co) [emen]

Contact manufacturer or distributors for more

Upgraded version .

CONFIGURATION IMPORT : You can read setup values saved in USB or
Initialize the setup values

CONFIGURATION EXPORT : You can record setup values in USB equipment.
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DATE/TIME

DATE/TIME
Set date, time & Time zone of System.

ACAUTION

B

TimE ZoME

When you use it for the first time
Set these items in advance .

DATLIGHT SAVING TIHE

It takes more than 50 seconds to
validate time setting.

TIME SYN
Synchronize time with internet time server. -
Default time zone is USA CST =

7 % DATE/TIME

ACAUTION | e

Set the GMT on the DATE/TIME list and
Adjust TIME SYNC.

NTP server function is only for DVR client

HOLIDAY
In the schedule record setup , it automatically
converts normal date to holiday schedule.

It works when record is setup as schedule mode.
It takes 90 seconds to validate holiday list
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|
DISK
DISK TABLE
Shows current disk information connected to -
system. ] Bisk-2

OISE3  TESTesrmCD-RAW 5.

IMPORTED : DISK installed
RECORD : RECORD possible
SYSTEM : DISK allotted for SYSTEM

TOTAL DISK FORMAT
Format all connected HDD disks. :
(When you select info column of connected DISK separately,
You can format DISK one by one.

It takes more than 200 seconds to format a 750 GB hard disk

ACAUTION

One of DISKS should be a system disk for recording system logs & other TEMP file issuing
purposes.

ACAUTION

Backup devices such as CD-RW/DVD-RW need to be installed as Secondary Slave.
(JR 2 Connector. — Slave jumper setting)

<SYSTEM DISK selected Screen> <On FORMAT Screen>
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USER

USER
Shows currently registered user lists.
User accounts can be added or deleted.

+ add account with this button.
X Delete account with this button.

USER ADD S
Possible to add user account | ISR ADD
according to authority. f

' PRSSWORD
| CONFIAM PASSWORD

| AumoRITY

¥ serue
¥ wrcaaoe

~ rommar
“ pamic nrconn

CONFIRM LOGIN
When YES selected, LOGIN needs to be confirmed every time to enter into setup /
system menu.

AUTO LOGOUT ENABLE
LOGOUT automatically after a certain period of time.

AUTO LOGOUT TIME
Set idle time to LOGOUT
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|
LOG
LOG
Shows all log infos on SYSTEM and other events
CLEAR : Remove all log info. m

UP/DOWN button : Move to next/previous log info
page by page .

2 Move to first part of LOG info.

Y. Move to Last part of LOG info.

LOGOUT
LOGOUT function when exiting set up

SYSTEM SHUTDOWN
SYSTEM ends.
The same as POWER OFF button of front or remote control.
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NETWORK

NETWORK
LAN
DDNS
E-MAIL
CcALLBACK

=

(2199% _ 2007708/16

NETWORK SETUP

LAN : IP setup
DDNS : DDNS setup

E-MAIL: Setup E-mail address for event message

CALLBACK: Setup computer IP for event message

|
\

an .

4

DEVICE RECORD ": .
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LAN

MAX CONNECTION
Up to 7 users

STATIC TYPE

For STATIC IP selection, settings for
IP, GATEWAY, NETMASK have to be
setup manually.

DHCP TYPE
For automatic DHCP IP selection, users only need
to set up the DNS data.

(DHCP operation mode must be structured under
IP sharing device)

ADSL TYPE

Please check your local ISP for the your ID
and password.

L RELR Y

sa13,80, 5800

" Tven
" o

§ REMOTE FORT
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DDNS(DYNAMIC DNS)

ENABLE
Select if you want DDNS

This is under the situation of Dynamic IP
Network.

SERVER
Select DDNS server

EZDDNS : Specialized DDNS server operated by server

DYNDNS: DDNS common server

In order to use DDNS service

Account & HOSTNAME should be registered in the server first.

HOSTNAME
User name of IP ADDRESS ON Dynamic IP circumstance.
It is the same name as registered on DDNS server.

USERNAME / PASSWORD
Type the user name & pas word registered on DDNS service.

ROUTER
Check if NETWORK is through ROUTER or IP sharer .

ACAUTION

Recommended to use EZDDNS Server rather than DYNDNS as DYNDNS is not optimized

The system.
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E-MAIL

ENABLE

Select when you need E-MAIL transmission.
ALL event information is sent to admin’s
E-mails.

ST SEEvEE

SMTP SERVER
Write the MAIL sending SMTP server name.

o v

AUTH ENABLE s
Check when you need account b o
authority. k| ¥ PASMORD
ID / PASSWORD

Input account & password .
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CALLBACK

ENABLE
Check to use CALLBACK function .

All event or specific information are sent to
“Agent” Program which is installed on P.C

CALLBACK ADD

Register IP address of P.C for callback
function

| ADONESS

o panT
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DEVICE

DEVICE
NETWORK CAMERA
ALARM
DISPLAY
MAIN MONITOR
SPOT MONITOR
MISCELLANEOUS

199% 2007

DEVICE SETUP

CAMERA : Camera setup

ALARM : Alarm setup

DISPLAY: On screen indication setup
MAIN MONITOR: Main monitor setup
SPOT MONITOR: Call monitor setup
MISCELLANEOUS: Key tone and keyboard

RECORD
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|
CAMERA
PO
T mwcamera
TITLE i e
Can change the camera name. i
HIDDEN

Doesn’t show the screen on live mode
Even though it records and runs normally.

PTZ ENABLE
Check if you want to use PTZ function.

PTZ PROTOCOL

Select PTZ PROTOCOL.
Various of protocol information including I
PELCO-D are implemented. o e
If you can not find one, please contact manufacturer ot | i

PTZ ADDRESS

When you use many of same PTZ equipments
You can name on these PTZ sites.

Site numbers can be from 0 to 255.

PTZ PORT
Adjustable related protocol BAUDRATE, DATA BIT.
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ALARM

ENABLE
Check if you use specific ALARM.

TITLE
Changes connected ALARM names.

ALARM TYPE
Select specific ALARM TYPE.
(NORMAL OPEN, NORMAL CLOSE)

p— s 1 .
MAIN MONITOR el 1] 6

N
L MAIN MONITOR

Set up SEQUENCE, EVENT POPUP
of main monitor.

SEQUENCE
Set up the screen switching times.

EVENT POPUP
Check if you want event pop up function.
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DISPLAY

Shows all OSD display details.

2 pispLAY

L

CAMERA INFOMATION s "w‘:.:‘:; —— =
Selects the display of CAMERA NO, TITLE

| DVENT mFQRMATION

< pvemt

4 FTATVS SPOL

Y am &

EVENT INFOMATION
Select OSD display for the EVENT.

STATUS INFORMATION
Shows various status of OSD.

SPOT MONITOR
Set up functions of SPOT MONITOR.

| SPOT HUNBER
| EMARLE SEQUENCE

1 FRED EaMERA

Seloct SPOT ou |
Select SPOT output numbers.

SPOT SEQUENCE ENABLE
Select SPOT switching channel.

FIXED CAMERA
Select the camera number not to switch .

SEQUENCE CAMERA
Select which camera to switch.

SEQUENCE DWELL
Adjust switching times .
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MISCELLANEOUS

e 2 g+ ]
Control of remote controller/key related functions. Vo

v
S MISCELLANEOUS

KEY TONE ENABLE
Select button volume on the front panel.
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RECORD

RECORD

DEVICE RECORD POLICY |
RECORD

= -

s i - Bie i
(4219,9.% 2007/08/16 16:38:08

RECORD SETUP

RECORD POLICY: HDD status setup when recording is full

RECORD : Recording setup (resolution, recording status, alarm, motion etc)
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RECORD POLICY
HDD status setup when recording is full
- Two types (Single Record, Overwrite)

RECORD
Recording setup for each camera

Remark:
Under half D1, the aspect ratio of local
AVI backup will be adjust to 8:3

RECORD MODE
Set up record type.
Default as OFF record mode.

NORMAL/EVENT RECORD FPS
Recording frame rate setup

NORMAL/EVENT RECORD QUALITY

Recording quality setup

SCHEDULE
Schedule recording setup

5 I | EAMERS NUMRER

| BESOLLTION
1 RECORD MODE

| SCWEDULE

i ' MORMAL RECORD FRAME RATE

| NORMAL RECORD QUALITY
1 EVENT RECORD FRAME RATE

| EVENT BECORD QUALITY
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EVENT

EVENT

DEVICE RECORD MOTION
SENSOR

VIDEO LOSS
SYSTEM

EVENT SETUP
MOTION : Motion setup
SENSOR: NO/NC setup
VIDEO LOSS: Video loss detection setup
SYSTEM: Event action setup
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|
MOTION
SETUP
Set up the MOTION area & sensor. Click mouse rlght or MENU KEY button

to see motion area window

Illllll l|llll1. aj.
BRI sl o] el
Iep— -~ ~ = =
| pmASLE - Ly -
o )
\ sEwsmRITY 7 Cwecr
= —
" anea
o
-]
e
o »

RECORD | [——s
Set pre& post record mode. |

o FUE nECORD

| POST RECOND

ACAUTION

When record frames are less, PRE/POST

RECORD need to be set a lot more for
correct record search.

ACTION

Setting up list for how to act after EVENT.
-POPUP CAMERA/DWELL

:Set popup channel & time.

-ALARM/BUZZER DWELL = [ —
:Set alarm & buzzer time. AT
-E-MAIL =y
:Select EVENT info to be sent by e-mail. : 1 ALR oWt
_CALLBACK :I\li’i’llﬂﬁlll
:Select EVENT info to be sent to AGENT. S
-WRITE LOG

:Select to write LOG info.
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SENSOR

SETUP
Set the SENSOR name & TYPE.

NORMAL OPEN : Normally it opens
and sends signals when detects sensors.

NORMAL CLOSE : Normally it closes,

and it sends SIGNAL when detects sensors.

RECORD
Set Connecting camera,
Pre, post record.

ACAUTION

When record frames are less, PRE/POST

RECORD need to be set a lot more for
correct record search.

ACTION

Setting up list for how to act after EVENT.
POPUP CAMERA/DWELL

:Set popup channel & time.
-ALARM/BUZZER DWELL

:Set alarm & buzzer time.

-E-MAIL

:Select EVENT info to be sent by e-mail.
-CALLBACK

:Select EVENT info to be sent to AGENT.
-WRITE LOG

:Select to write LOG info.

— ——
25 CH-2| | EREE a4vCHa -
= ~ -

.
! B SENSOR

RG] * rerevon womnen

B | 1 e

O wamE
¥ SEwsOn TYRE

Siwsony

w | SEMSOR NUMBER

=00 1 LNKED carma
o PRE NECORD

¥ POST RECOND

SENBOM HUMBER

e it
1 @ senson

POFUP CAMIRA
' POFUR DWELL
| LOREED ALARM
| ALARM DWELL
| BUZZER DL

" A

| CALLBACK

| WRITE LOG
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VIDEO LOSS

VIDEO LOSS can be an event type and
can set camera record and action.

SETUP
Select whether you want VIDEO LOSS
Function or not.

RECORD
Set connecting camera Pre& post record.

ACAUTION

When record frames are less, PRE/POST

RECORD need to be set a lot more for
correct record search.

ACTION

Setting up list for how to act after EVENT.
POPUP CAMERA/DWELL

:Set popup channel & time.
-ALARM/BUZZER DWELL

:Set alarm & buzzer time.

-E-MAIL

:Select EVENT info to be sent by e-mail.
-CALLBACK

:Select EVENT info to be sent to AGENT.
-WRITE LOG

:Select to write LOG info.

CAMERA WUMBER

EmanLE

1 ‘¢ viDEo Loss

| CAMERS WuMEER
| LINKSD CAMINA
| PRE NECORD

| POST RECOND

! CAMIRS NUMEIR
| POFUP CAMIRA
| POFUR OWELL

| LORKED ALARM

" ALAEM DWELL

| BUZZER DL

" Eman

| CALLBACK

1 WRITE LOG
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SYSTEM

Sets how to operate event related with
DISK mainly.

DISK FULL
Sets when HDD is full of record.

DISK ERROR
Sets when there is an error on HDD.
This function has been removed.

S.MAR.T

Enables the system to prevent possible
malfunction of HDD by interfacing
between system and HDD.

¥ ALARM DWELL
| BUTTER OWELL
b s

| cALLBACE

| wTE LOG

| LINKED ALRSM
| ALANM DWELL
| BUZZER OWELL
§ bR,

| EALLBACK

1 WnITE LOG.

| oanr s AT

) LINKED ALARM
§ ALARM DWELL
¥ BUZTER OWELL
T

i cALLBACE

¥ wTE oG




SEARCH

®

10.CH10 l11.cH11 [12.cH12

13.CH13 14.CH14 15.CH15 16.CH16

9 2007/07/19 02:49:43

@ Playback Screen : Video playback screen
@ Playback Time : Playback Time Display
@Display screen indication:

Playback Icon
Pause (Il)
Playback (>)
Multiple Playback(> », » » », » » » »)
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SEARCH MENU

CALENDAR
EVENT

Garo

FIRST

LAST

ROOKMHARK

BACELP

BiEICE

STOP

W hrapen

BT
2007/07/19

DISPLAY
Select screen division mode. (1,4,9,16 split screen)

CALENDAR SEARCH
Select date , hour, minutes, seconds in calendar search.
When you click MINUTE, you can find the specific record status under minute base

2.CH2Z

Q, DETAIL VIEW

o

|
<= QT
< QT

o

LI
- s N
> [
< NTmnm
o= Jimnnmm

2007/07/13 00:46:16
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EVENT SEARCH

It shows all EVENT record list.
If you click related EVENT,

It plays that event promptly.

IoreAne BRINTT maTIon : 3
P moTIoN - w

ACAUTION

It may not be the same channel image as
shown on EVENT LIST because it shows the
first display image recorded at that time zone.

SEARCH KEY

B ser joaia ea:u:77 [H)
Can be selectable on EVENT search. N 2007 100 /10 _a2:30:n [H
-START/END 0 —
:Set EVENT search start, end time. Bred ' soeon

-MOTION/SENSOR/VIDEO LOSS
:Selectable per each camera |

DATE/TIME SEARCH

Search data by Date/Time .
You can search the event promptly A AT
When you know the exact event time. A ' v oaia srean
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FIRST
Move to the beginning of the recorded data.

LAST
Move to the end of the recorded data.

BOOKMARK 10.CH10 11.CH11
When you set up a Bookmark time, this time will be
set as the starting time during back up.

15.CH1S

2007/07/19 02:49:43

an®

PLAYBACK USER INERFACE
Playback buttons appears when locate the mouse pointer at the bottom of screen

= »
007/08/16

& el

A

SEARCH KEY

PLAY/PAUSE : Press PLAY to start from the position that was stopped from previous playback

<] | Step backward / calendar search in | [> Step forward / Event search in live mode
live mode

<]<] Fast backward / Beginning of [>[> Fast forward / Last record time in live mode
record time in live mode

[] Stop playback (Return to Live Display)
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DEVICE

Search for internal record disks or external
Backup devices.

LOCAL DEVICE
Search the data of internal DISK.

BACKUP DEVICE
Search backup device (Select when you play the backup data.)

If there are various back up devices , you can select a specific one .

It only supports DVD +R/-R and CD RW discs for backup

If you can not play the AVI file from backup, please visit Xvid web site at http://www.xvid.org
to download the Xvid codec for installation.
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REMOTE

AWl saving begins.

Image Saving,.,

Printing...
W

<REMOTE PROGRAM IS?>
With connected to DVR remotely, it is to perform Remote Monitoring, Remote

Search, Remote Backup etc. (Please install remote program from the program
CD)

Environment conditions for Remote Program

1. INTEL P-4

2. 256M or higher main memory(512M recommend)

3. WINDOWS O/S(WIN 2000, XP, Vista(32bit))

4. 32MB VGA card supports RGB (ATI series recommend)
5. At least 10Mbps network speed (Max 100Mbps support)

Please note that some buttons and graphics may not be activated at this moment.

Those inactivated buttons will be used later when system upgrades and expands
If the viewer opens on IE, user needs to put connection IP on

Select Internet Options > Security > Trusted sites

ADD this website to the zone



46

Remote Control : Use Windows IE Browser

User can use Windows IE Browser connected to the remote DVR system .

Note : Right now no support Firefox browser connected to the DVR system .

First time use the IE Browser connected to the
DVR system , it will display

“Click here to install the following ActiveX control :
‘WebControl.cab’ from ‘CMC TECH INC.’

Press the install button to install the

WebControl.cab to your computer

After install WebControl.cab completed ,
your IE Browser will display DVR control center,
Login with ID and Password , then you can

control the DVR system through the IE Browser .

[ —

o

Bl

=]

Internet Explorer, - Security Warning @

Do you want to install this software?
Mame: webControl.cab
Publisher: CMC TECH INC.
More options Instal Don't Instal

1 “ehile Files From the Internet can be useful, this file bype can potentially harm
wour computer, Only install software From publishers you krust. What's the risk?

3 b 1921 606, T4 TW ey, i - W rosafl I v Explo
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After login successful it display ON-LINE

Also you can use the client side application to
Remote control your DVR system .
Download this Remote control software just press

this button then it will auto download the software .

URL of remote software download

http://www.ultracctv.com/downloads/software/setup
_tigon_1648.exe

ON - LINE

@@ Network Speed
c] rost Nel -iou ]
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@ Connection information
and Button

6Ch NTSC Shows DVR’s name, IP address and connection
© 192.168.5.112 status.

OnLine

DVR connection button.

Back 1600 HTSC ... 5111
Hlack 166% PaL <am
Black 9CH PAL 152.168.5.49 Off e

— Add : Enter IP address and user authentication
to connect DVR
Modify : Modify IP address and user authentication

| of the existing list
i | owsnea | Delete

: Delete existing use.

<DVR Connection Window>

Add/Modify ]

—Connecting information
DVR name: [Black 16Ch PAL

Addrass: [192.168.5.201

Service Port: |9013 _,j

DVR name :

Specify a name that you can easily

~User certification identify.
User Name: fadmin
Address :
Password: |*

o _ Specify assigned IP address to
¥ Certffication Information Save connect DVR (Type the Host hame of

REAL IP or DDNS.)
Ok I Cancel

<New Connection/Modify Dialogue Window>
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<What is IP address?>
A set of address system that is used to find out destination in network access via
Internet or LAN.

IP address is divided into REAL IP and VIRTUAL IP, and REAL IP must be sent on
DVR for the access from remote site via internet. You can be assigned with REAL IP
Or DDNS service ID (Hosthname of Dynamic Domain Name Server).

Service Port :Set this the same as the service port assigned to DVR.

<What is service port?>

Function to make the virtual IP available to the devices such PC or DVR with

Automatic connection to the specified service port when remote access is made
To router via the router or IP Share of one REAL IP. (But this function is available
Only when router or IP Share supports it.)

User Name : Type the user name authorized in DVR
Password : Type the password authorized in DVR

Save Authentication Information :Save Authentication Information

@ Program Information and Set up

RTILITT™
[} o

Program information

Program Information :

Shows Remote Program’s XQLive

information. Version :0,0,6,0
Last Update: 2007.07.23
Net Version: 0.7.9.0

<Program Information Window>
Program Setup :

Sets up Remote Program.

(Language, Display Output, Resolution, Save Path, Network
Speed Etc)

"tagmunsnt®
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Program setting i
~program Language : ’
To choose program’s language.
Language: =
Video Display :
Video display methods = YUV " RGB play

™ Resolution from 1024X768 starts

(*adaptable after rebooting.)}

- Etcetera
Data save place: |C:WUSer5W‘9._E’—“.WDesktc _I

AVT saving time: IlU __1::' Minute

~Network circumstance

Metwork Speed: ' High Speed ¢ Low Speed

ok l Cancel

<Program Setup Window>

<Recommended Graphic Card>

YUV mode : According to your PC
graphic card ability, the support can be
decided. This mode shows faster,
clear ability of image transmission than
RGB mode.

RGB mode : It is widely compatible
with most graphic cards, and select
this when YUV mode is not supported..

Resolution from 1024X768 starts :
It always shows 1024 x768 when you
check..

X Above setting value will apply after

restart of the program.

ATl series : Radeon7000series (More then 32M), RADEON series...

NVIDIA series : M64series(More then 32M), GEFORCE series...
Etc : VGA card to support YUV mode YUV...

Data Save Place :Sets ups basic path of AVI file to save.

AVI Saving time : Sets up saving time of AVI file from remote.

Network Speed :

High Speed : System sends off images at high speed possible.

Low Speed : System sends off images at normal speed in consideration of stability.

@ Status Icon

Status icon of connected DVR
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Recording status 3

[cH | Resoution [  Frame [ Picture Qu...|  Sound |

01 - - - -

02 360X240 5fps Narrral Not use

03 720%240 1fps Norrmal Not use

o4 360x240 1fps High Mot use

0s - - - -

06 360X240 Sfps High Not use

o7 720X240 1fps Normal Not use

08 - - - -

09 - - - -

10 - - - -

11 360X240 Sfps High Not use

12 720X480 30fps Highest Not use

13 - - - -

14 720X480 ifps Horrmal Not use

15 720X480 1fps Mormal Not use

16 720X480 1fps Norrmal Not use
Close

‘1‘2‘3|4|5|6‘7‘B‘9‘10‘11‘12|13|14|15‘16

o /"8 video signal

<Recording Status>

Shows and check the recording status

<Event Status>

Shows DVR’s event status and you can
check the status of Motion, Sensor,

:’ o :_ Video Loss at real time.
"tanaumann®’
Alrm control
Alarml FAE] T OFF
i o e <Alarm Control>
Alrm3 ON OFF
Arma on OFF You can On/Off the DVR’s alarm if you press
Close the Alarm control button.
Type | Capacty | Used | Temperatur| SMART | <HDD Status>
HDD1 111GB 99% 37C Good
HEDS aace | 2% At Gaod Shows the connected DVR HDD status.

HDD3 279GB 01% 39'C Good
HDD4 - - - Mo support

@ REMOTE SEARCH Execution and Set Up

REMOTE SEARCH Execution

You can check temperature and status
at real time.

Set Up Execution

Pressing each button operates
REMOTE SEARCH or Set Up.

REMOTE (LIVE) and REMOTE
SEARCH are made up in separate
program.
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Remote Set Up <Camera>

PTZ Marne:
1D:

Port Bitrate:
Data:
Stop:

Parity:

Q Audio Setup

Audio Channel:

=~ Device ‘Dewce = Camera
Cameta
Alarm Q Camera
=I-Record
Record Camera Mo,
Record Policy
< Event 9 Title:
Motion I~ Covert Camera(Hidden)
Sensar
Widen Loss Linked PTZ
System 9 W B BT

1 El
|cHL

|8 TECH CCD ZooM =
[ 0
o500 =]
e =
i El
‘Nnme j
3 =

ok ‘ Cancel | Apphy |

@ Camera Enable has been removed.

@ Title : Item to revise/type the camera name.

IF Security : When checked, It displays ‘Hidden’ on monitor. (though it keeps recording)

@ Link PTZ : Sets up PTZ camera.

IF PTZ address: Item to assign PAN TILT address per camera.
Name :ltem to check PTZ Camera’s model name.

ID : Item to select PTZ address per camera.

Port bit rate : Item to select the PTZ’s port bit rate.

Data bit :Item to select data bit.
Stop bit : Item to select Stop bit.
Parity : Item to select Parity.

@ Audio : Item to select which audio channel to be used among total 4 audio inputs.
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Remote Setup <Alarm>

E-Device IDe\rice = Alarm
H Camera
[ o) Alarm
= Save
. Record 1 Lo I1 j
i Record Policy
iyt ¥ Enable
- Motion
Title:
- Sensor IALARM]'
Video Loss
System Type: |N0rma\ Open j

cancel

@ No : Item to select Alarm No.
To set up all the camera equally, Choose “select all”

F Enable : Item to select to use Alarm, Removing the check stops using that channel.

Title : Item to type Alarm’s name.
Type : Item to select Alarm’s type.
- Normal Open : Type of alarm open in general situation.
- Normal Close : Type of alarm close in general situation.
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Remote Set Up <Record>
Setup —
E-Device Isave = Record
. Camera
§ b Alarm Record ﬂ
- Save .
T 1 No: |1 ﬂ
; Record Policy Resalution: -
Lo [720x480 =l
- Motion Record Mode
i |Event Recording(E) j
Video Loss Normal Recording Frame: |1 fps j
System
Normal Recording Quality |Ngrma\ ﬂ
Event Recording Frame: |1 fps ﬂ
Event Recording Quality IH|ghe§t j
Schedula
G MON| TUE | WED| THU | FRI | SAT | SUN
00:00
01:00
02:00
03:00
04:00
05:00
06:00
07:00
08:00

@ No : Item to select Camera No.
To set up all the camera equally, Choose “select all”

Resolution : Item to change the resolution.
- NTSC : 720X480, 720X240, 360X240
-PAL :720X576, 720X288, 360X288

Normal Record Frame :ltem to select normal record frame.
Normal Record Quality : Item to select normal record quality.

Event Record Frame :Item to select Event (Motion + Sensor + Video Loss) record speed.

Event Record Quality : Item to select Event (Motion + Sensor + Video Loss) record quality.

Schedule : Item to select record schedule.

- Normal : Always Record

- Event : Motion, Sensor, Video Loss
-N+E :Always + Event Record

- Clear : Delete the current record schedule.
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@ Remote Set Up <Record (Timetable)>

LN )
V“ ..v
. .

—Schedule

MOMN | TUE | WED | THU
—

1. Select the
i~ Clear R Record Mode
..

., *®
®"saggun®

2.Select Day/Time

< Schedule of Record>
Itis the list of selection in which schedule to
use in operating the relevant camera channel.

Schedule Indication by color

Normal(N) : (Blue) First select the item you need among
Normal time, Event and Normal time + Event.
Event(E) : (Red)

Normal(N) + Event(E) : (Green) Then drag mouse from the wanted position
on time line.

Clear (No Record) :

(White) X To edit schedule record,

you need to set record as schedule mode.




Remote Set Up <Record Policy>
Setup

B Device ISa\re > Record Policy
i~ Camera
i Alarm Record Policy

[tk olicy:

- Record 1 Recycle j

= Event

i~ Mation

- Sensor

- Video Loss

i~ System

cancel

@ Record Policy: Item to select record policy

Overwrite : When HDD capacity is almost consumed, It erases old data and record new.
Single Record : To stop recording on 100% of HDD capacity.
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Remote Set Up <Motion>

= Device ]Event = Motion

o Camera
H Alarm
= Record
- Record
H Record Policy
= Event
_
- Sensor
- Video Loss
System

Setup
L Camera ko,
v Enable Mation Detection

Sensitivity:

Area:

Linked Record. .

1 E

Detect Clear

I Linked Action., I

| A pply |

Cancel

ok |

@ Camera No : Item to select Camera No.

To set up all the camera equally, Choose “select all”

F Enable : Selects to use motion sensor, Removing the check stops using that channel.

Sensitivity : Adjusts the sensitivity in motion detection.
There are 5 steps and as the number increase, it gets more sensitive.

@ Area : Item to select motion area.

Clear

' Detect

Area is selected when drag the mouse on the
image.

<Set Up Area Tool>

[Wv Clear
| |

Area Clear
Button

Area Detect
button
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@ Remote Set Up <Motion (Link Record)>

Link Record

rRecord

Link Camera:

Pre Record:

Post Record:

[T 2 3 2

5 6 7 8

9 || asd] AL | 22

13| 14| 15| 16

55‘ Second
105' Second

Cancel

Link Camera :

Selects which channel to record when
motion is detected on the relevant
channel.

¥ Multiple selection possible

Pre Record : Sets pre-event recording time. (Max 5 second)
Post Record : Sets post-event recording time. (Max 60 second)

@ Remote Set Up <Motion (Link Action)>

~Action
Popup Camera: ll _vj
Pupup Time: l—s-_—_'l Second
Link Afarm: Il—i‘.ilﬂ
Alarm Time: I—E"_"l‘ Second
Buzzer Time: lﬁ Sacond
I~ mail
Iv Calback
" Log

Cancel

Alarm Time

Popup Camera :

Selects which channel to Popup when
motion is detected on the relevant
channel.

¥ It works when the Popup setting is
‘Yes’ on DVR.

Popup Time :
Sets Popup time

Link Alarm :

Select Alarm to be linked when motion
Is detected.

¥ Multiple selection possible

: Sets Alarm output time. (Max 30 second)
Buzzer Time : Sets buzzer output time in DVR. (Max 30 second)

F Mail : When motion is detected, the log is sent to the selected e-mail.

F Call Back : When motion is detected, the log is sent to the selected IP address.

IF Log : Iltem to save Log writing when motion detected.
(It is not recorded on the system Log but used for event search.)

Motion detection function is a mode to detect in accordance with the amount of color
Changes of image. So, please be careful that DVR keeps recording as continuous

motion when the image of camera is blinking caused by light problem or camera
Auto Iris problem.
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Remote Set Up <Sensor>

0

= Device [ Event > sensor
. Camera
i e Alarm Setup
- Save
| 1 Jpensor No: |1 2|
i Record Policy
iyt ¥ Enable
~ Motion .
_ e Name: [sensor1
Video Loss .
System Type: [Normal open =l

2 ©)

Link Record... | Link Action.. |

cancel

Sensor No : Sets sensor No.
To set up all the camera equally, Choose “select all”

IF Enable : Selects to use sensor, Removing the check stop using relevant sensor.

Title : ltem to select sensor’'s name.

Type : ltem to select sensor type.

- Normal Open : Type of Alarm open in general situation.
- Normal Close : Type of Alarm close in general situation.
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@ Remote Set Up <Sensor (Link Record)>

Link Record

rRecord

Link Carnera:

Pre Record:

Post Record:

1 2 3 i

5 6 7 8

ol el 11 |

13| |14 15| 16

5 _I:l Second
10 _‘:l Second

Link Camera :

Selects which channel to record when
sensor is detected on the relevant
channel.

% Multiple selection possible

Pre Record : Sets up pre recording time. (Max 5 second)
Post Record : Sets up post recording time. (Max 60 second)

@ Remote Set Up <Sensor (Link Action)>

~Action

Popup Camera: |1 j
Pupup Time: I—s_—J Second
Link Alarm: IT_ZILILI
Alarm Time: |—5._J' Second
Buzzer Time: l—g:" Second
I~ Mail
IV Calback
¥ Log

Cancel

Alarm Time

Popup Camera :

Selects which channel to Popup when
sensor is detected on the relevant
channel.

% It works when the Popup setting is
‘Yes’ on DVR.

Popup Time :
Selects Popup time.

Link Alarm :

Selects Alarm to be linked when sensor
is detected.

% Multiple selection possible

: Selects Alarm output time. (Max 30 second)

Buzzer Time : Selects buzzer output time. (Max 30 second)

F Mail : When sensor is detected, the log is sent to the selected e-mail.

F Call Back : When sensor is detected, the log is sent to the selected IP address

IF Log : Iltem to save Log writing when sensor detected
(It is not recorded on the system Log but used for event search.)
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Remote Set Up <Video Loss>
Setup

- Device
: Camera
i e Alarm
- Save
- Record
i Record Policy
E-Event
- Motion
- Sensor

System

I Event > Video Loss

Setup
1 JFamera No: |1 j
¥ Enable

2 | ©)

Link Record... Link Action.. |

cancel

@ Camera No : ltem to select camera No.

To set up all the camera equally, Choose “select all”

F Enable : Selects to use Video Loss.
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—_ l
@ Remote Set Up <Video Loss( Link Record)>
Link Record
~Record
Link Camera: 1 2 3 4

3 6 7 8

e | v

13| 14| 15| 16

0 _lj Second
0 _‘? Second

Pre Record:

Post Record:

i Cancel

Link Camera :

Selects which channel to record when
video loss is detected on the relevant
channel.

% Multiple selection possible

Pre Record : Sets up pre recording time. (Max 5 second)
Post Record : Sets up post recording time. (Max 60 second)

©)

~Action

Popup Camera: |1 j
Pupup Time: I—g_—J Second
Link Alarm: ;I_ZILILI
Alarm Time: I—O._J' Second
Buzzer Time: l—g:" Second
I~ Mail
I~ calback
[~ Log

Cancel

Remote Set Up <Video Loss (Link Action)>

Alarm Time

Popup Camera :

Selects which channel to Popup when
video loss is detected on the relevant
channel.

% It works when the Popup setting is
‘Yes’ on DVR.

Popup Time :
Selects Popup time.

Link Alarm :

Selects Alarm to be linked when video
loss.

% Multiple selection possible

: Selects Alarm output time (Max 30 second)

Buzzer Time :Selects buzzer output time (Max 60 second)

F Mail : When video loss occurred, the log is sent to the selected e-mail

F Call Back : When video loss occurred, the log is sent to the selected IP address.

IF Log : Iltem to save Log writing when video loss occurred.
(It is not recorded on the system Log but used for event search.)
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Remote Set Up <System>
Setup

= Device | Event > system
5 Camera

i e Alarm Disk Full
- Save
! - Record ¥ Disk Full Notice Enable
i Record Policy
E-Event

- Motion

@ Link Action..

~ Disk Error

Iv Disk Error Enable

@ Link Action..

SMART

¥ SMART Enable

@ Link Action..

cancel

@ DISK FULL : List for all installed HDD disks.

F Disk Full Notice Enable : Activate Disk Full Notice when installed disks are full.

@ Remote Set Up <Disk Full (Link Action)>

~Action
Popup Camera: I j
Pupup Time: l—g:ll Second
Link Afarm: IT_ZI LI LI
Alarm Time: |—5:|' Second
Buzzer Time: l—D:" Sacond
I~ mail
™ calback
" Log

Cancel

Popup Camera :
Not available as of now

Popup Time :
Not available as of now

Link Alarm :

Selects which Alarm to be linked when all
installed HDD disks are full.

% Multiple selection possible

Alarm Time : Selects Alarm output time. (Max 30 second)
Buzzer Time : Selects buzzer output time (Max 30 second)
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F Mail : When all installed HDD disks are full, the log is sent to the selected e-mail

F Call Back : When HDDs are full, the log is sent to the selected IP address.

F Log : Selects to save Log writing when installed HDDs are full.
(It is not recorded on the system Log, but used for event search.)

@ Disk Error : Shows data error on all of the HDDs installed.

F Enable Disk Error : When there is a disk error, it is linked to action.

@ Remote Set Up <Disk Error (Disk Action)>

Popup Camera :
Not available at this moment

Popup Time :
Not available at this moment

Link Alarm :
Selects Alarm to be linked when HDD
error.

¥ Multiple selection possible

Link Action

- Action
Popup Camera: | j
Pupup Time: [—E Second
Link Alarm: E“;m_zj.ilLl
Alarm Time: [—Dj Second
Buzzer Time: 'ﬁ Second
I~ Ml
™ Calback
¥ Log

Cancel
Alarm Time : Sets Alarm output time (Max 30 second)

Buzzer Time : Sets buzzer output time (Max 30 second)

F Mail : When HDD error occurs, the log is sent to the selected e-mail

F Call Back : When HDD error occurs, the log is sent to the selected IP address.

F Log : Selects to save Log writing when HDD error.
(It is not recorded on the system Log but used for event search.)

@ SMART

F Enable SMART : Select to use SMART feature.

SMART Function??

It checks the physical errors and observes the HDD disk continuously such as
Temperature, I/O device errors and general conditions of the HDD disk.
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@ Remote Set Up <SMART (Link Action)>

T
~Action

Popup Camera: | j
Pupup Time: I—U:ll Second
Link Alarm: IT _2' LI LI
Alarm Time: I—O._J' Second
Buzzer Time: l—g:" Second
I~ Mail
I~ calback
¥ Log

Cancel

Alarm Time

Popup Camera :
Not available at this moment

Popup Time :
Not available at this moment

Link Alarm :
Selects which alarm to be linked

¥ Multiple selection possible

: Sets Alarm output time (Max 30 second)

Buzzer Time : Sets Buzzer output time (Max 30 second)

IF Mail : When smart related problem occurs, the log is sent to the selected e-mail.

|7 Call Back : When problem occurs, the log is sent to the selected IP address.

|7 Log : Selects to save Log writing when smart related problem occurs
(It is not recorded on the system Log but used for event search.)
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@ PLAY & PAUSE

Starts or stops image transmission on the Remote Live screen.
This starts automatically when search or set in the setup menu.

) Cou

Starts to play when pressed. Stops to play when pressed.

@ AUDIO Transmission

Controls Audio volume. »Audio signal is sent on full screen mode only.

> Sound volume control gauge

T Mute Button :
Q Stops audio transmission.

@ Right Mouse Click Action

When the right button is clicked on Remote Live, the following menu below appears and the
following functions can be used.

G Whole Screen : Hides the function
Whole 1= button and shows the image full
screen.

Al SE hEng"' AVI Saving Begins :

|I'I'IE|EIE SEI'-.-'iI'IEI, i Starts AVI saving of the channel
Printi Selected.
I’II'ITII'IEI, X ¥ Audio signal is saved on full

screen mode only.

Image Saving.. : Save image file of channel selected (Save JPEG or BMP)
Printing.. : Print current image of the channel.
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Channel Button

Moves to the channel selected and it has the same function as double click the left mouse
button on the selected channel.

00000000

@ Layout Modify Button

Screen Division Button : Selects desirable screen division.
Whole Screen : All buttons are hidden and the screen displays full.

X Left double click of mouse returns to the previous screen from whole screen.
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PTZ Operation

O

ZOOM FOCUSs

Preset Move: Move to saved preset No.

Preset Save : Save preset No.

Location: i ﬁl

<Preset Move>

A camera supporting PTZ can be
used on Remote Viewer program.
X Refer to PTZ support list

Direction Button :
Button to move top, bottom, left, right

Channel Indication :
Indicate current channel

Speed Control Button :
Button to control moving speed

Image Control Button :
Button to adjust Zoom, Focus, Iris

Pre set move button

Pre set save button

Freeset setting o

Setting:

<Preset Save>
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Remote Search

@ Playback Display

Camera Name ==

Recorded
Date/Time

@ SECTION

SECTION

—

S vicn nrsc
192, 1

)

117 30 L2l b

Ayl Saving...
Image Saving...
Printing...

EihuwRum:lﬁ r
[} \ .’.

Green Border Line :
Display the selected
camera.

Selects section

Section is created when Date/Time is changed to former time.
Former Date/Time will be kept in section 0.
Newly set Date/Time will be kept in section 1......

**Only one remote-playback connection is allowed
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@ Move & Event Search

Start: Time: 2007-07-26 11:17:24 )
| » Shows start and end time of recorded
Tl [2007-07-30 14:50:55 " data.
: 07-30 14:00- = > .
Go to time: [2007-07-30 14:00:00 = P Moves to the time to search and press
OK button.
Cancel
<Move Window>
[Event Search
[~ SearchCondition
2 2007-07-26 11:17:24 _‘1‘ .
e | - » Select the time to event search
Ending Time |2uu:r-u7-3u 14:50:55 =
| Detaedcondition [ 1 [2[3[4[5[6[7 89 [10]11]12[13]14[15]16
¥ Mot . .
S _ Select events in detail.
>
V¥ NoVideoSignal
[¥ Recordcamera ‘ $» Select the camera to search.

| Start Start event search. Click below Import
[ button to list events
Event Time Event ] "
2007-07-26 12:21:34 Sensor-1
2007-07-26 12:21:28 Sensor-1
2007-07-26 12:20:26 Sensor-1
2007-07-26 12:20:02 Sensor-1
2007-07-26 12:19:46 Sensor-1
2007-07-26 12:19:27 S -1 I i
e » Shows current searched event lists.
2007-07-26 12:18:11 Sensor-1
2007-07-26 12:17:45 Sensor-1
200707:2612:17:3% | senaok-7 Hotkey :Play the searched event.
Click Stop button first and select a
certain event list and click Hotkey to play
the event.
Hatkey et | :

Import : Search the next event list.
% 10 lists are shown every time clicks

<Event Search Window> import buttton

Please make sure to select “WRITE LOG” of the system.

If not, event lists aren’t searched.




71
|

@ Connection Information and Button

Shows DVR’s name, IP address and connection
192.168.5.112 status.

OnLine

Backup play button

> Connect/Disconnect Button :
Button to connect to other DVR in the saved list

[DVR Connection When many DVRs are registered

in the DVR list, each DVR can be
remotely searched without closing

The Remote Program.

‘ DVR: I[Sih’er 16Ch NT5C] 192.168.5.112

The linked list s can’t be edited
while search.

<Connection List Window>

(5) Playback Button

Play / Pause
Previous Frame :

Play previous frames :;lleXt Framfe :
reverse direction : ay next frames

forward direction

Starting :
Move to starting
of record data

End :

Move to end of record data

Fast Rewind : Fast reverse
play every 1 minute

Fast Forward :

Fast play every 1 minute
Speed Control Bar
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@ Screen Division Button

Screen Division Button

@ AUDIO Play

Controls audio volume. ¥ Audio signal is sent only on one full screen.

> Sound volume control gauge

Mute Button :
Stops audio transmission

A 4

Image Control Button

Brightness

Contrast Brightness adjustment button :

. Adjusts the brightness of playing images.
Blurring

Sharpness Contrast adjustment button :
Adjust the contrast of playing images.

Blurring adjustment button:
Adjusts the blurring of playing images.

Sharpness adjustment button:
Adjust the sharpness of playing images.

Reset button :
Initializes the adjusted image to original image.

»

Zoom Button :
Zoom the selected part
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|
@ Saving Button
Back Up :
Backup Backup the searched image as
compressed image file.
Print

Print :

Image Save

I AVI Save

~Starage Infarmation
Starting Time! |2nm‘-u?-za 23:00:00 j
Ending Time |2nu?-u?-2a 23:00:00 ]l
sincms [[RE[A[5[e[1[¢
Pl ERkss o |
Including: [ Audio [~ Event
~BackupDevice
BackupPath; |C:WXQ TestBK_20070726_230000
TotalCapacity: | 99939 B
LeftCapaciy: | 55311 mp
| 0%
Start =] Close

<Backup Window>

Print the searched images.

Image Save :
Saves the searched images as Image File.
(Save JPEG or BMP)

AVI Save :
Saves the searched images as AVl file.

Storage Information :
Select start and end time to backup
image.

Backup Camera :
Select the camera to backup

Including :
Selects audio and event to include.

Backup Path :
Selects the path to backup

Total Capacity :
Shows total capacity

Used Capacity :
Shows used capacity

Left Capacity :
Shows remaining capacity
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Printing Preview

DVR Print

<Preview Window>

Image storage ,

Saving Information
Camera: CHO4
Saving Path: |C:WBK_{H 04_20070730_140024.jpg

ok Cancel |

<lmage Save Window>

Preview :

Preview of the images to print,

which is printed with various information
written on the bottom of the image.

Image Format

JPG format :

Definition has a little loss due to loss
compression method, but archiving size
is small.

BMP format :

Archiving size is a bit big due to no
compression, but it can be saved as
higher definition than JPG.

Saving Path :
Selects the path to backup.
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Dalaistoite L Storage Information
~Saving Information Selects camera No and start/end time to
Backup Camers;  [CHO# save.
StartingTime: |2nu7-u7-3u 14:00:39 =
EndingTime |2nu7—u7—30 14:00:29 = Including :
Selects audio to include.
Including: [ Audio
i Back Up Patch :
[ EehipDancE Selects the path to backup
BackupPath; [c4#XQ TestBI_CHo4_20070730_14003¢[E3
Total Capacity: | 999099 Total Capacity : ]
Shows total capacity
Left Capacity: | 55310 1B
I 0% Left Capacity :
Shows remaining capacity
Start S Close |

<AVI Save Window>

Check “Caption option” of Media Player to display time/date of playing AVI file.

Right Mouse Click Action

When the right button is clicked, the following menu below appears and the following
functions can be used

Originalzize Original Size : Shows original size.
'|':‘||'I.‘,I'| S al.',li n g AVI Saving :

B Starts to save AVI file
Image Sawing...

e % Audio signal is save only on full
Frinting, .. screen.

Image Saving.. : Save image of the selected camera (Save JPEG or BMP)
Printing.. : Print current image of the camera
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@ Time Table

Selects year/month/day and hour/minute to search the recorded data.

Year/Month Select Button :
Button to move previous and next month.

Recorded Date (Blue) :
Shows recorded date in blue.

Current Date (Blue Round) :
Shows current date in blue round.

\ 4

No Recorded Date (Black) :
Shows no recorded data in black.

Timeline Display : Displays in 24 hours system and one each line is 1 hour unit.

1052073408 (6 7 18901091712 13 14 1596 A7 181920 "1 (22
ST o AN A A S LB S e 1512 ITTSEEE ST ST 5T LN [ TSe FSS BN AT AT ISR TR

MIN o - 10 15 20 25 30 35 40 45 50 55 | ]
CH 13 7 I .0 0 S s S 6 9 5 5 5 5 5 [ 5 5 S [ S35 4 5 P P 4 5 B 1 7 S T 8 S0 4 4 [0 V.1 5 0 (24 5 9
L "IN s e S S S S S S A U S O S SO S S S U

257017 0 1 T T 1 5 5 A 5 5T A 1 X B Lt 5T 2 50 55 T4 A K50 5 3 [ P

TP P e D ] TIP3 T ﬂ

. ) Minute selection Pointer::
Camera Selection Button : Select the minute.

Select the camera.
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@ Backup Playback

. ‘ Backup Playback Button :
L Click to backup playback

x|
5 - EciE
Select the backup data to play.

Backup playback can play a data

of Image file.

Windows Media Player can play a
Flename (M):  [<0 TestR_20070725_020000-00 data of AVl image files .
Filetype (T): [Backup File (=1db | Cancel | |




78

PLAYER

(5] XQPlayer : C:WUsersW 2 91 AW DesktopWXQ TestWSilver 16 NTSC GMT +03WRemote Search Back upWWXQ Te

Camera Name =9 ShDWR_DDII;II__" F

Green border line :
Display the selected
camera.

Recorded
Time/Date

@ Starting/End

} ! }

Move to starting record data Play Progress Bar Move to end of record data
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Fast Forward
Fast Rewind

Stop
Play / Pause

@ Sound volume Control Button

XAudio signal is sent only on one full screen.

» Sound volume control gauge

Mute Button :
Stops audio transmission

Layout button : Button to select screen division mode .
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@ Call function/Program Info

Call Function Button :

Button to call in the back up file.

Information :
Shows program
information.

N =
Location (i [ 1]} fiemote Search Back up -] - B E
tradified date ~| Sie [+l
Flename (N):  [X0 TestHr_20070 725 (20000-00

File bype (T}

[Backup File (=1db | Cancel
[

2

Program Info

@ XQPlayer

Version: 0, 0, 6, 0
Build: 2007.07.23

oK |

<Program Info Window>

Select the backup data to play

Backup playback can play a data
of Image file.

Windows Media Player can play
a data of AVI image files .
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Program execution

» Login

User Authentication

User:

Passwiord:

When program is first executed, puts in ID,Password

Default — ID: admin , Password: 1.
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CMS Main screen

C 3)
e
el

C

@ Function button

@ User Management

User Management

| Usir Name Description @\1
i_ )
|

[ add.. ][ Edit. ][ Detete |

Add, edit, delete of CMS account.

>>Add: add CMS user
>>Edit : revise user ID, PASSWORD

>>Delete: delete user
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@ CMS System Requirements

oS Win 2000 / Win XP / Win Vista
CPU INTEL P-4 2.4Ghz or over(recommendsP-4 3Ghz,over )
Main Memory 512MByte or over (recommends 1Gbyte,over)
Video Memory 64M over supports RGB (recommends 128Mbyte over)
Resolution 1024*768 over
Lan Card 10/100 Supporting card
Protocol TCP/IP




Chapter Il 84

Add User

» User name :

Type the user name authorized in DVR
User Mame :

»Password:
Type the password authorized in DVR

Password :

User Description:

[ Confirm ][ Cancel ] )>Userexp|ain:
Shows the user information

<Use management add/modify >
@ Option management

[ — >Language : To choose program’

language.
Language glish o .
e = = »Video output : ATI
Scresn Output Method & H © RGB YUV mode : According to your PC
(* Please restart program to apply) graphic card ability, the support can be
decided. This mode shows faster, clear
ability of image transmission than RGB
are for saving data D: ¥
e [ ssvma e (] mode.
sawing time 1o = Minute -
st = »RGB mode : nVidia
It is widely compatible with most graphic
Transmizsion Speed & High Speed  © Low Speed cards. and select this when YUV mode
is not supported.
Event Soound D: ¥ @
X Above setting value will apply after
(close ) restarting of t

<Option management>

<Recommended Graphic Card>
ATl series : Radeon7000 series (More than 32M, more than 64M recommendable), RADEON series...

NVIDIA series : More than M64 series (Min over 32M, more than 64M recommendable), GEFORCE series
Etc :VGA card to support YUV mode... , Recommended 2 times memory when dual monitor is used.

»Date save place
Sets ups basic path of AVI file to save

»AVI Saving time
Sets up saving time of AVI file from CMS.

»Network Speed
High Speed : System sends off images at high speed possible.
Low Speed : System sends off image at normal speed in consideration of stability.

»Event Sound
Set ups sound file (*.wav), when the event occurs.
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@ Group management

Group Manamement

Group Mame | Description |
I
[ ade. ][ Edi. ][ petete ]

Add Group

Group Mame

Group Description

{ Confirm }{ Cancel }

Add, modify and delete a group in DVR

»>Add... :Add a group information
>Modify...: Modify a group information

»Delete : Delete existing group information.

»Group name :

Specify a group name in DVR
»Group information:

Specify a group information

X To register DVR , you need to register a group first.
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@ DVR Management

DYR MANAGEMENT

TP Addh

Add /modify/Delete DVR connection in
the CMS

Group Mame

Add : Enter IP address and user
authentication

Modify to connect DVR

: Modify IP address and user

authentication of the existing list

([ age. J[ Ean. ][ petere | Delete

: Delete existing use.

DVR ADD

»DVR name:
VR Name Specify a name that you can easily
identify.
o
HEh »Group :
Connect Infarmation = Select the DVR group
Address >Address :
e IP address to connect
i 2013 =
aestieh = (type IP or DDNS Host Name)
User Authentification »Service port :
1 Set service port same to DVR'’s one
zer Mame
»User name:
HEEEe Type user name of DVR authorized
¥ Bundie Connactic
{ Confirm ] { Cancel J

»Password : Type password to DVR authorized .

»Connect all : connect all when it connects
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@ VIEW Management

View Management

Wiew harne Type -

[ agd. [ edit. )[ Delete |

Close

Add View

Wiew Mame :
Type : o Live " Map

Map Characteristics

Map File C]

Wiew Name :
Type : % Liy 1 Map

Map Characteristics

Map File : C]

(ot )Camer )

Adds, edits, deletes Live/ E-map showed in CMS

»Add... : add View information
»Edit... : edit View information

»Delete : delete View information

»View name :
put in any name for user to know easy

»kinds :
select LIVE or MAP

»Map file :
In case the View is map, select to be used
image

»View name :
put in any name for user to know easy
»Map file :

In case the View is map, select to be used image
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Program Information

Program Informat

LN xooms

Wersion

11,0,6,0

Last Update: 2007.11.16

Lng Viewer

Available to run the Log Viewer of

the version and updated Information

on CMS.

]

FH A
DR [ Log Azt [e= [E EEE
206_1 2007-06-07 15:35:55 Try Connect 1921686206 9013
206_2 2007-06-07 15:35:55 Try Connect 1921686.206 9013 —
148 2 2007-06-07 15:35°55 Try Connect 1921686148 9013
206_3 2007-06-07 16:36:55 Try Connect 1921686.206 9013
148_1 2007-06-07 15:35:55 Try Connect 1921686.148 9013
180 2007-06-07 15:35°55 Tty Connect 1921686180 9013
206_1 2007-06-07 15:35°55 Connected 1921686206 9013
206_2 2007-06-07 15:36:56 Connected 1921686.206 9013
180 2007-06-07 15:35:56 (200HHES H CheE,.. 1921686180 9013
206_3 2007-06-07 15:35°56 Connected 1921686206 9013
145 2 2007-D6-07 15:36:16 {2003 &S S ChZE . 1921686148  9M3
1481 2007-06-07 15:36:16 (2003F &S & ChE,. 1921686148 9013
206_1 2007-06-07 15:36:45 Disconnect 1921686206 9013
206_2 2007-06-07 15:36:45 Disconnect 1921686206 9013
206_3 2007-06-07 15:36:45 Disconnect 1921686206 9013
206_1 2007-06-07 15:66:27 Try Connect 1921686206 9013
206_1 2007-06-07 15:56:27 Connected 1921686.206 9013
206_1 2007-06-07 15:50:42 Try Connect 1921686206 9013
206_1 2007-06-07 15:53:43 Connected 1921686.206 9013
206_1 2007-06-07 16:03:43 Try Connect 1921686206 9013
206_1 2007-06-07 16:03:44 Connected 1921686.206 9013
206_1 2007-06-07 16:05:03 Try Gonnect 1921686206 9013
206_1 2007-06-07 16:06:02 Connected 1921686.206 9013
206_1 2007-06-07 16:06:58 Try Connect 1921686206 9013
206_1 2007-06-07 16:06°58 Connected 1921686206 9013
1481 2007-06-08 181216 Try Gonnect 1921686148 9013
148_1 2007-06-08 18:1 301 {2003} &5 & 2= S&LICL HBH... 19216865148 | 9013
206_2 2007-06-0819:16:29 Try Connest 1921606206 9013
Erras 30T NE 18 10450 Ter et 1 aes s e anas 2
Log Viewer

By CMS, it makes the log of time, IP address, connecting port and status on

connecting system.

@ Program Exit

It exits CMS.
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(® DVRTree
©OECa @ €=

= 0
(3)=m 192 1685002

= F Carm

&4 shaw Room

@ 7 setting
7 Road
B2 Hall
B4 Productline
F Dioor
g4 g
B4 subwway
B4 Hyundai APT.
F Meeting Room
B4 sales Team
B Skylife
£ road
£ T.0.M Office Door
F Flavaround

4 00

@ Sensor 1

@ & sensor 2
B sensor 3

@ Sensor

@ All Connection

It connects all DVRs nominated on the DVR
information.

@ All Disconnection

It disconnects all DVRs connected on the
DVR information.

@ Group

Indication of the Group of the DVR

@ DVR

E=1 Indication of disconnect DVR
=4 Indication of connect DVR

@ Camera

Making the camera icons enabled, on
connected with the DVR.

F Indication of the camera status disconnected
with the DVR
-7 Indication of the camera status connected with the DV

Indication of camera status on the motion
detection

Indication of camera status on the video
loss

Making the sensor icons enabled, on connected with the DVR

@ Indication of the sensor status disconnected with the DVR

Q Indication of the sensor status connected with the DVR

@_ Indication of sensor status on the sensor detection
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@ Channel name

@ Recording Status

@ DVR name
@ Current time

Pop-up menu on clicking the right button of mouse,

*Stop : Temporary stops the current image of live view.

*Close: On the live view, it deletes the live channel.

Saving Image file,,,
Print,.. image.

sImage storage : Storage of the current live view as the

Al *Print: Printing out the current live view.

*AVI : Storage of the current live view as AVI file.

<AVI Storage>
On storing AVI, it stops the archive automatically by the setup time

on the option, without any stop order.

@ Screen Splitting Button

e || === | ==

It supports up to 64 screen splitting.

 Full Screen Button

-

It shows the view of live screen. .

@ Screen Movement Button
&) 48 >

On the splitting live screen, it moves the next or the before.
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@ r1z

PTZ Disabled PTZ Enabled

On clicking the PTZ button, the PTZ control panel appears. If the selected camera
has the disabled setting of PTZ, it will be disabled status like No.1pic. If not, it will
be enabled status like No.2pic.

Preset Movement ‘Z|

@ Preset Movement

i £
Location 1 | It makes the preset moved to the selected area.

( Movement |

Preset Setup |X‘ @ Preset Setup

Location 1 — It sets up the preset to the selected area.

_Se_tu_p 3 | Close
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@ Enabled camera connected with DVR @ Live view of selected camera
@ Sensor Detection of DVR @ Motion detection of the camera

] ] connected with DVR
@ Disabled camera connected with DVR

@ It makes other maps connected
(Map Link)
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Usage of Dual Monitor

LIVE |0 M

Wove to 2nd Monitor

v Event Poplp..,
Ewent Sound

Initialize MAP

I

On clicking the right button of mouse on the E-map tab, the pop-up appears.

»Dual monitor movement

On the dual monitor function, the selected map is moved to the second monitor.
»Event pop-up

On detecting motion, Pop-up automatically.

»Event sound

On detecting event, the sound (that is set up on the option) happens.

»Initialize map

Initializing the map screen.

' v Fixed
2x Zoom

|

Clase

Fixed Screen Released Screen

Pop-up screen Window pop-up menu

»Fixed

On selecting it, the live pop-up window is fixed. Unless fixed, the screen will be
closed automatically any times later. If fixed, the lock image will be shown on the
right top of screen.

»Zoom-in double times.

Zoom-in of live pop-up window by double-times.

»Close
Closing the live pop-up window.



